
  
National AIDS Spending Assessments 

Resource Tracking System 

 
 

 

 

 

 

 

 

 

 

User Guide - 2009 
  

 

 

 

 

 

  
 

 

 

 

 

 



NASA RTS: User Guide 
UNAIDS 

 

 

 

 

 

 

 

NASA RTS 

National AIDS Spending Assessments Resource Tracking System 
 

 

First Edition, 2006 

Second Edition, 2007 

Third Edition, 2009 

 

All Rights Reserved 

© UNAIDS 

20, avenue Appia ● CH-1211 Geneve 27 ● Suisse 

 

 

 

Program and Informatics Development: Carlos Martínez de la Roca 

 

 

 

NASA RTS is free distribution software, developed by UNAIDS to promote the 
utilization of information on the making of decisions that contribute to rise and 
enhance the level of improvement of the resources destined to confront the AIDS 
epidemia. 

Available at: 
http://www.unaids.org/en/KnowledgeCentre/HIVData/Tracking/Nasa.asp

 

All comments by the users about this version posted as text files on the UNAIDS website 
(www.unaids.org), will be appreciated. 

2 

http://www.unaids.org/en/KnowledgeCentre/HIVData/Tracking/Nasa.asp
http://www.unaids.org/


NASA RTS: User Guide 
UNAIDS 

 

Contents 
 

STARTING POINT ......................................................................................................................................... 4 
MEANING OF THE ICONS .................................................................................................................................. 4 
OPERATIONAL DEFINITIONS............................................................................................................................ 4 
SYSTEM REQUIREMENTS ................................................................................................................................. 5 
INSTALLATION PROCEEDINGS ......................................................................................................................... 5 

INTRODUCTION............................................................................................................................................ 6 
OPERATIONS WITH PROJECTS................................................................................................................ 9 

NEW PROJECT.................................................................................................................................................. 9 
OPEN AN EXISTING PROJECT.......................................................................................................................... 11 
CLOSE SESSION ............................................................................................................................................. 12 

OPERATIONS OF DATA ENTRY.............................................................................................................. 13 
SOURCE, AGENTS AND PROVIDERS ENTRY.................................................................................................... 13 
AGENTS AND PROVIDERS ENTRY .................................................................................................................. 16 
GENERAL VIEW OF THE DATA ENTRY FORM................................................................................................. 17 

EDITION OPERATIONS ............................................................................................................................. 25 
EDIT ORGANIZATIONS................................................................................................................................... 25 
EDIT TRANSACTIONS..................................................................................................................................... 25 

EVALUATION............................................................................................................................................... 27 
ASSESSMENT................................................................................................................................................. 27 
BALANCE ...................................................................................................................................................... 30 
CATALOGUES ................................................................................................................................................ 30 
MATRIX......................................................................................................................................................... 31 

TOOLS ............................................................................................................................................................ 33 
UPDATE CURRENT PAGE ................................................................................................................................ 33 
ADD USER ..................................................................................................................................................... 33 
COMPACT AND REPAIR DATA BASE................................................................................................................ 34 
IMPORT A NASA RTS DATABASE FROM ANOTHER COMPUTER ..................................................................... 34 
EXPORTING OR BACK-UP OF THE DATA BASE ............................................................................................... 36 
CONFIGURING SYSTEM IN MULTI USER MODE ................................................................................................ 37 
SECURITY...................................................................................................................................................... 39 
OUTPUT FOR PIVOT TABLES.......................................................................................................................... 40 

 

 

3 



NASA RTS: User Guide 
UNAIDS 

Starting Point 
This section specifies the guide’s icons, frequently used terms, specification of minimum system 

requirements and software installation proceedings. 

 

Meaning of the icons 
 

The guide is organized in a way, that 
the user can gain direct access to the 
components of the program, the parts 
that build the main menu, or the 
different types of relevant information 
regarding the handling of the software.  

During the initial lecture or when you do 
a quick search of specific aspects, the 
icons on the left provide orientation 
about the type of information presented. 

 

 

 

 

 

 Basic 
Information 

Initial orientation and description 
of the components of the 
software. 

 Proceeding Indication of the steps to follow to 
complete a proceeding. 

 Resources Additional resources in support to 
the software operation. 

 Attention Warning about precautions that 
need to be taken before 
proceeding with the next step. 

 Note Extension and explanation related 
to the external, but 
complementary, proceedings of 
the software. 

 Go To Link In the electronic version of this 
guide this sign will direct you to 
relevant additional information by 
clicking on it. 

 

Operational Definitions 
 

Transaction Basic unit of the financial flow. It describes the resources’ way 
from a source to an agent, the subsequent distribution from 
the agent to the supplier, who can assign them to budgetary 
items to develop one or more functions of services addressed 
to specific beneficiaries. 

Financing Source Entity who acts as a financing resource towards functions related 
to the response to HIV and AIDS. In some cases the Financing 
Source can earmark their funds to specific functions or 
beneficiaries. 

Financing Agent Intermediaries in the health system. 

Provider Entity responsible for the delivery of goods or services, 
supporting the response to HIV and AIDS. 

Function Group of services or goods, organized in homogeneous and 
excluding categories. 

Beneficiary Target group of the actions undertaken. 

Budgetary item Budgets and elements of spending that represent the 
acquirements and contracts of providers for the production and 
delivery of goods and services. 

Some frequently used 
terms in this guide have 
meanings that may not 
coincide with their sense 
in other contexts.  

The correct use of these 
terms is fundamental to 
guarantee consistency 
and comparability of the 
results in different 
countries and/or over a 
certain period of time. 
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System Requirements 
 

Before installing NASA RTS, 
please make sure that your 
computer supports the 
minimum system 
requirements. 

Hardware Processor Intel Pentium 500 MHz to Windows 
2000 

128 MB of RAM memory. 

1 GB of available space on the hard disk. 

Operative System Windows 2000 
  

 Software Microsoft Office 2000 Professional (including 
Microsoft Access)  
Internet Explorer (optional in this version) 

 
Monitor VGA with minimum resolution of 800 x 600 

 

Communication 

 

 Internet access (optional in this version) 

  

 

  Installation Proceedings 
 

The installation process should be 
easy. The installation program will 
guide you step by step through the 
different phases of the installation 
process. 

1 Insert the CD in the CD-ROM unit of your computer. 

2 Alternatively you can download the latest version of the 
program here: . 

3 In the CD Menu choose the file Install.exe. 

Your current system may not have 
installed some libraries needed for the 
execution of the software’s 
commands; they have been included 

in the Install.exe file to ease the installation. 

4 Double click on the Install.exe file to unpack. Follow the 
instructions of the self-extractor. The file is programmed to 
create a new folder inside the Program Files. This can be 
changed in the self-extractor window. 
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Introduction 
 

A stroll through NASA RTS 
National AIDS Spending Assessment (NASA) is the term currently 
used for all country activities related to the tracking of resources 
dedicated to the response to HIV and AIDS. NASA is based on 
standardized methods, agreed definitions and accounting rules of 
the system globally available and internationally accepted for the 
National Accounts, National Health Accounts, National 
Autonomous AIDS Accounts and Budgetary Analysis. 
 
NASA uses the same categories for tracking resource flows as the 
Resource Needs, making the two methodologies comparable and 
offering more possibilities of analyzing the results. 
 
NASA offers information on the resource flow of a country’s 
response to HIV and AIDS and can therefore support the 
mobilization and application of resources. NASA does not only 
provide the information needed to report progress towards 
UNGASS, but can provide more detailed information on financing 
sources, as well as functions, agents and providers. 
 
The NASA RTS program serves to facilitate the data collection and 
analysis. While the program is opened, the user of NASA RTS will 
find a main menu with seven derivative menus: a) File; b) Data 
Entry; c) Edition; d) Assessment; e) Report; f) Tools and g) Help. 
 

 

The File menu can be used to create a new project, open an 
existing project, close the session of the current project or close 
the program entirely. 

The Data Entry menu gives access to the different data entry 
screens organized by the different stakeholders that are involved 
in a specific country. Here the user can enter transactions, either 
from agent to source or from agent to provider. 

The Edition menu offers access to previously entered 
information. Here data can be modified and/or edited. 

The Report menu generates the output of the results of the 
tracked resources. 

The Help menu offers direct access to this guide and to the 
Microsoft Access Help. This gives the user a quick and easy 
access in the case that problems occur. 
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What are the 
system products? 

The Data Entry phase is the most complex of the system, and 
the main outputs are the different matrices that describe the flow 
of resources in different combinations. The system also produces 
a summary matrix, organized by consolidated categories. 

The products of the Data Analysis phase are the financial 
indicators that the system produces, which relate the entered 
spending data with each other as well as to the population of the 
country, general health spending and the estimated GDP. 
 
NASA RTS is capable of storing various projects using the same 
base. Therefore multiple countries and/or years can be stored 
within the same program. NASA RTS has security characteristics 
to avoid data loss or alteration. When a new project is created, 
the author can allow access to different users that will be allowed 
to edit the information. Through access passwords each alteration 
can be reconstructed. 

Is there any 
protection for the 

system data? 

 
The estimation process of the national accounts on HIV/AIDS can 
be organized in different ways; the technical guide of NASA RTS 
suggests the following process: 

Working Process 

1. Data Collection:  
In some cases this step is not easy to manage as many 
organizations (governmental and non-governmental) do not like 
to disclose their financial data. Ongoing verification of the 
collected data and quality control are essential in this phase. 

2. Processing of the Data:  
The organization of the collected information according to the 
specifications of the National AIDS Spending Matrix can now be 
realized with this specially-designed software. The data entry 
must be combined with the verification of transactions where 
blanks, inconsistencies or other risks exist. In some cases, it will 
be needed to realize new data searches. 

3. Analysis and Interpretation:  
During this step, the program conducts the estimations that are 
needed to complete the financing flow. Indicators that relate to 
the HIV/AIDS spending like the national health spending, total 
country population or people living with HIV/AIDS will be 
calculated. The results should be interpreted in relation to 
additional data from the country (epidemiological situation, 
conditions of the health services system etc.). Discussion and 
conclusions of the study should finalize this step. 

4. Disclosure and Use of the Information:  
This step describes the write-up of the report and its 
dissemination. The information and the results described in the 
report should serve political decision-makers to take the right 
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decision regarding the level and distribution of available resources 
to confront the epidemic. 
 

The contribution 
of NASA RTS to 

analyze spending 
on the response 

to HIV/AIDS 

NASA provides valuable information to national authorities. They 
can use this data to identify and achieve their targets in the 
context of the National AIDS Programs. Through institutionalizing 
the estimation process and conducting it on an annual basis it can 
serve them in the longer term and minimize the cost and effort 
needed over time. In this sense, NASA RTS is the result of the 
explicit demand of different countries in the world, especially 
those who have developed estimations and are looking to 
facilitate the process.  

NASA RTS is a computational tool that simplifies the integration of 
data that comes from different sources and varied texture. It 
helps the national accounting teams to gather information and 
conduct the estimation. It ensures greater consistency and 
comparability between the countries, as they can use a uniform 
classification structure. 

NASA RTS though already used in a number of countries, it still 
needs improvement and is continually updated. .The NASA RTS 
tool is understood as an organically unfinished product that needs 
continuous adaptation to the needs and conditions of each and 
every country. 

The doubts, comments or critics about the current version will be 
considered as useful contributions to the improvement of the 
software, and multiple ways will be opened for the countries to 
transfer the elements of feedback to the coordination team 
responsible for the technical improvements of the NASA 
methodology. 
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Operations with Projects 
A project in NASA RTS 
comprises the full 
estimation and analysis 
of a country’s spending 
data over a period of 
one year. 

The file menu includes 
these operations: 

- New Project 

- Open Project 

- Close Session 

- Exit (the 
program) 

This section describes 
how to work with 

projects, their purpose, different proceedings and warnings for the adequate use 

 

New project 

 
The initial step to develop an HIV/AIDS spending practice with NASA RTS is to create a 
new project. NASA RTS can store several projects at the same time. When a new 
project is created, the environment of the practice is delimited. The elements that define 
a new project are: country, year that the estimation refers to, organizations responsible 
for the development and users authorized to edit data. 

 

 
When “new project” is selected on the 
“file menu”, a screen opens up to 
confirm that the user wants to start the 
new project. This way, accidental 
entries in the project-opening routine 
are avoided. 

 

 

By clicking yes, the system unfolds a 
screen where the user is asked to enter 
some initial information about the new 
project. The required information 
includes the name of the country, 
region and the year of the estimation 
The responsible entities of the study 
can also be entered at this stage. 

After completing the entry, the user 
can click “ok” if the data is complete 
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and correct, or cancel the entry. The latter will close the screen without saving the 

ts each user authorized to 
enter or modify data to sign in with their per

pears where the users need to 

sure that the entered password 

ristics, the system keeps an internal 
gister of the modifications done by each user. 

project.  

The newly created project needs some security conditions. In many cases the project 
will be utilized by many users. Accordingly, the system reques

sonal password. 

When the “ok”-option is clicked on the 
General Opening Data window, a new 
screen ap
register. 

Requested fields are name, position and 
password. A password-verification space 
exists to en
is correct. 

By pressing “ok”, the window will close and 
the new project is created. In the 
background we can find information on the 
country, the year of the estimation and the 

active user. This information helps to avoid confusion when simultaneous projects are 
handled on the same computer, e.g. sub national entities (provinces, states or 
departments). As part of the security characte
re

  

 

 

 
 
 
 
 

This information 
shows which Project 
is opened. 
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Two warnings are needed regarding the password. 1) To add a new user to an existing 
project, there is no need to create a new project. When the project is opened by 
the authorized user, the new user can be added via the tools menu. 2) to avoid security 
failures, the signed-in user always has to know the password. So it might be  advisable 
to choose a password that is easy to remember and/or keep it in a safe place. 

Open an existing project 
NASA RTS is able to keep several projects in the same data-base file. This allows the 
user to compare different years and countries. Some characteristics of the consult and 
report menus cannot be utilized if the project is not opened. Since the user may open 
and close the project several times on the same workin g day, an entry routine has been 

eated to facilitate the opening of an existing project. 

w screen will show the catalogue of 
xisting projects for which the user is authorized. 

 

country, year of estimation, user name and data that identifies 
e project will appear. 

cr
 
By clicking “Open” in the “Project” menu, a window pops up, requesting a user name 
and password. There are two possibilities when this information has been entered: a) if 
the user or the passwords are incorrect, the system opens a window informing the user 
that the user name and/or password are not valid. By clicking the “OK” button, a new 
window pops up, warning that the opening of the project has been cancelled. b) If the 
user name and password are both correct, a ne

 
e

 

 

 

 

Wrong data 

 

 
Correct 
data  

 

 

 

 

 

 

 

 

Select Project by double-
clicking the arrow on the 

border of the form. 

 

 

 

Through a double-click on the arrow left of the project name, the project opens up and 
the screen showing the 
th
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Close Session 
Normally, the teams working on the estimations consist of numerous users. If users 

 leave their working station the project should always be closed in order to minimize the 
risk of losing data and/or other people editing it 
he “Close SesT

R
sion” operation allows the closing of the project without ending the NASA 

TS program. 

l store each 
pdate,

 

 

 

nfirmed or denied 

ase. If the program is closed with the session or project still open, data might be 
st.  

 

 
On the “Project” menu, select “Close Session”. The current project will close and the 
ackground screen will clean the country, year and user data. NASA RTS wilb

u  so there is no risk of a data loss if the project is closed by accident. 

 

 

 

 

 

 

 

 

 

 

 

When closing a project the system will ask to verify 
this command; this must be co
according to what is required at the moment. 

It is important to know that the data base saves data 
while it is edited during an open session. So once the 
session is closed, the information is secure inside the 

data b

 

 
lo
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Operations of Data Entry 
The operations for new data entry on the 
data base are available in the data entry 
menu. New organizations, new sources, 
agents and providers that take part in the 

saction are entered here. same tran

 

Source, Agents and Providers Entry 
Below you can see the data entry screen. It shows the year of estimation in the header 
and the amount of the transaction. The basic flush shows boxes to enter source, 
agent, and provider. Each one of these requires the functional classification, which is 
loaded to selection. A chart will be shown on the lower-left side where the source of 
information will be classified. It is important for the u ser to know that the information 
will not be saved, unless all fields are filled correctly.  

 

H
ea

de
r 

B
as

ic
 F

lu
sh

 

Header 
In the header row of the transaction screen you can find three items: the number of the 
transaction, the year of the estimation and the total amount. The number of transaction 
is assigned automatically and is used for internal identification. In the date field, the 
user must enter the year when the transaction took place. In the amount field, the total  
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of transferred resources from the source to the provider will be entered automatically 
after all the information on the transaction has been completed. 

 

  

  

basic flush of 

t and item chain. To ease this 
assification, a selection form has been created. You can activate it by double-clicking 

in the blank spaces of the source or provider window. 
 

 

 

Basic Flush 
The resources transferred from the source to a provider represented the 

System- Year when 
transaction took 
place.  

Amount of 
resources from 
source to provider.  

assigned 

 
number of 
transaction.

the transaction: all the elements of detachment (function, target group and spending 
objects) have as a reference the link between these two types of entities. 

The source and provider data correspond to prior established classifications that must 
e respected through a component, sub-componen

 
b
cl

 
Double-click here to open 
selection of sources.  

Double-click here to open 
selection of agents. 

Double-click here to open 
selection of Providers. 

 

 

 

Selection of Sources  
The option differentiates on a component level between public, private and external 
sources.  Each one of these components is divided in sub-components, and these in 
items of selection. When the component (higher-left box) is clicked, the sub-co mponent 
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(higher-right box) will appear. When the sub-component option has been chosen, the 
item attached opens together with a description, to make the selection easier,  

 

atalogues can be printed from the report menu of NASA RTS, including the 
io

category. 

ication as a financing source and can  be selected from the 

 

In some cases, the search of the route to the item of classification may seem 
complicated, particularly when the user is not yet familiar with the classification. The 
different c
source classifications. A printed copy of the classificat ns may help to find the correct 

The entry space of the source 
also includes an area where 
specific entities that finance the 
response to HIV and AIDS can 
be selected. The list that 
appears corresponds to the 
entities that were entered into 
the directory of institutions. If 
the source that the user needs 
does not appear in this 
catalogue, it can be entered in 

the Edit / Key Organizations and Informants menu; after entering an entity it will 
appear in the classif
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institutions catalogue. By clicking the arrow to the right of the field the user can easily 
access the catalogue 

The same proceeding is needed in order to select an agent; in this case, the institutions 
that appear in the catalogue are the ones that were marked as agents before when a 
card on the social response form was filled. To select agents, the user can also use the 
functional catalogue. It can also be printed in the Report/Catalogue/Agents menu).  

 

 

 

Agents and Providers Entry 
The data entry screen shows the year of estimation and amount of transaction in the 
header. The basic flush includes the boxes where transactions from agent to provider 
can be entered. Each one of these requires the functional classification, which is 
preloaded for selection. There is a board showing the detachment per function in the 
lower part of the form. When the sum of the function amounts coincide with the total of 
the transaction, the totals on the board change from the original in red to yellow, 
indicating the partial square of the elements. The detachment of every function can be 
detailed by budgetary item or target group; for this, double-click the row of the 
unction on the left side of the board. Thi

 
f s opens a new form with two flanges; one for 
udgetary items and the other for target groups. The process to input data in this new 
rm is explained on the following pages. 

 
 

b
fo
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General View of the Data Entry Form 
 

 

 

The selection of the agent corresponds to a standardized classification, but the entry 
space of the agent allows to enter and select specific entities of the country participating 
in the financing of the response to HIV and AIDS.   The list corresponds to the list of entities that were entered in the institution directory. 
If the agent who is involved does not appear in the list, it can be easily entered in the 
Edit/Organization menu, or if entered previously it can be marked as an agent. This 
way, it will appear in the catalogue of institutions to be selected.  The illustration below 
shows the catalogue of entities. To access the catalogue the user only has to double-
click the bottom row of the entry field. 

The selection of providers happens in the same way, although in this case, the 
institutions that appear in the list are those that were marked as providers on the social 
response form. The selection can also be done through a functional catalogue of 
providers (that can also be printed on the Report/Catalogue/Providers menu). 
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Detachment by function 
The lower part of the data entry form shows a board with the fields needed to identify 
the function in which the resources were consumed, the percentage of the total amount 
of the transaction that each function consumed, and the corresponding amount to the 
function.  
Like in the NASA RTS forms, the entry of data must be done BY ROW, completing the 
each row fully before passing on to the next one. If done in a different way, an error 
message will be appear. To pass from one field to another, the tabulator: [TAB] or 
[ ] key can be used, as well as the return [ENTER], [Return] or [ ] key. 

To select a function a form of selection similar to the sources and providers is used. As 
reference, the complete catalogue of AIDS Spending Categories (ASCs) can be printed in 
the Report/Catalogue/Function menu. 
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After selecting the function, either [TAB] or [ENTER] keys are pressed to enter the 
Amount field. The amount that was used by the provider to accomplish the function 
needs to be entered here. NASA RTS will automatically calculate the percentage for the 
the particular function compared to the total of the transaction that can be seen in the 
header row. 

If amount spent is inserted without having indicated the total of the transaction before, 
an error message will occur. In this case, the user must press the escape [ESC] key and 
enter the total amount of the transaction. Afterwards, the user must return to the 
function field and press the tabulator [TAB] key to update the field before passing to the 
next row. 

The correctness of the function is verified in two ways: a) the total percentage and 
amount that appear on the bottom of the board - when they match with the total of the 
transaction, the color will change from red to yellow. b) A red light appears on the left 
border of each function, indicating that the function is not closed in the 
detachment by budgetary item or target group. To detach according to these 
elements, double-click the left border of the detach function. The form that contains the 
board of detachment by budgetary item and target group will open up. 
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Detachment by Budgetary item 
The form that is used to detach the function has a header that presents the number of 
the transaction, the ASC that is being detached, the percentage of spending of this 
transaction, and the amount of spending for this function. Two boards detail the 
budgetary item, and the target group (beneficiary population).  

 

Here the first step would be to select the budgetary item in the first row. The entry 
must be repeated for each row to show all interventions for the particular amount of 
money. The selection can be done through a catalogue of budgetary items which can be 
reached by double-clicking on the blank space that corresponds to the budgetary item. 
Again, printing and consulting the catalogue of budgetary items on the 
Report/Catalogue/Budgetary items menu can be helpful. 

The catalogue organizes the different goods and services in four big components: work 
(basically personal services); goods (different kind of materials, equipments and 
infrastructure); services (those that the providers hire from third parties) and transfer of 
funds (sums of money that are transferred to accomplish a function, e.g. personal travel 
allowance). 

After selecting the function, the user must press the tabulator [TAB] or the return 
[ENTER] key, which will move the cursor to the amount column; the amount of the 
specific item will be entered here. The system will automatically calculate the 
percentage that represents the budgetary item according to the total of the function. 
The total spending will appear at the bottom of the board in proportion to the entered 
budgetary items, until 100% is reached. 
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Detachment by target group 
The board to enter the target group of the intervention is similar to the previous board. 
It also shows the percentage and amount dedicated to each group..  The selection of a target 

group is done through a 
catalogue that can be 
accessed by double-
clicking the blank space 
of the row. 

The selection is similar to 
the budgetary items 
catalogue, and a 
catalogue of target 
groups can be consulted 
on the Report / 
Catalogues / Target 
Groups menu. 

The selection of target 
groups is not always 
clear, because sometimes 

interventions are directed to segments of population that fit more than one 
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classification; e.g. sexual workers that also are migrants. In this case only one target 
group should be selected. It is recommended to use the category that fits most the core 
group of the epidemic: in this example, sexual worker and not migrant. 

 

The cursor must be placed on the observations box to pass to a new transaction, and 
then press either the tabulator [TAB] or return [ENTER] keys. 

 

Closure Verification 
Once all information available for the transaction has been entered, it is important to 
verify the transactions that were left without accounting closure. The identification of 
the incomplete data is important. In some cases an additional data search on the 
institutional registers will be needed; in others, they might need an estimation based on 
the gathered data. 
 
The accounting closure can be verified immediately in the data entry form of the 
transaction, or in the screen showing all of the transactions at once. 
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In the processing phase, all financial data will be entered into NASA RTS. Since the 
closure of estimation and integrity of the matrix depend on this accounting logic, it is 
important to explain how NASA RTS operates this process of data integration.  The traditional way of closing the estimation was determined by the basic risk unit, 
which was the specific spending. Whether it was the payment of a provider or the hiring 
of personnel, this number constituted the basic risk unit. In a matrix each amount is 
related to two of the following classifications:.source, function, provider, budgetary item 
and target group. When accounting for each and every amount in the filled matrix, the 
challenge was to ensure the complete integrity of the matrix. In several cases it took 
several hours to identify accounting asymmetries. 

The lights lights on the left of the function and the total will indicate if the calculations 
are correct; the lights on the right of the function field indicate the level of advance by 
the color of the lights on the function, budgetary item and target group columns. 

 

 
NASA RTS proceeds with a different logic. The basic register unit is the transaction. In 
one transaction all of the elements of the financing flow are put together. 
 

A transaction is the transfer of resources 
from a financing source to a provider of 
goods or services, who invests in different 
budgetary items to produce functions of the 
response towards HIV and AIDS that will 
benefit specific groups of populations or the 
population in general. 

S P

1

2

3

OS TG

P

 

Functions

1 4

A 

The illustration shows the financing flow linking the 
source (S) to the provider (P) via the agent. P can 
develop the functions (1, 2, 3, 4). The budgetary 
items (OS) are articulated as the function of 
producing goods or providing services towards 
target groups (TG) 

The identification of transactions starts with the 
Organization and Assembly phase. The source-
provider relation is established here, transfer 
mechanisms and all kind of activities that are 
financed this way are identified. The planning and  
data collection will lead to the volume and 
distribution of each and every transaction. 

In the diagram, the financing source and the financing agent are represented in the first 
two green blocks. These differ in color from the following fields as they represent a pure 
financial flow between these entities. That means, NASA RTS is capable of detaching the 
financing flow that comes from the financing source to various agents from the 
description of details concerning the distribution where functions, beneficiaries and 
budgetary items come to the transaction. 

 
NASA RTS monitors the entry of incomplete transactions and totals that are not closed 
on each and every level of the financial flow hierarchy. Graphic symbols help to locate 
missing information. If all transactions are complete and closed, the matrix and 
estimations will close as well. 
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Progress Analysis 
The analysis of the progress in the data processing differs from the direction boards of 
the previous phases. Here, the board shows the elements that build the transaction 
such as column headings. The transactions are represented in rows. The boxes that 
show the result from matching the columns and rows can come in two conditions:   

a) GREEN: Closed transaction on the level;  

b) RED: Unclosed transaction on the level; 

The transaction that shows a red light can be opened from the board by double-clicking 
on the grey border left of the transaction. This will open the screen of data entry, to 
review (and complete) the element. 

Other operations that can be conducted on the data progress board are: 

a) Order: when positioning the cursor over a column and double-clicking on the 
letter icon, all transactions will re-order according to the column. Text fields are 
ordered alphabetically, whereas the lights will be ordered according to their 
color. 

 b) Filter: after double-clicking the filter icon, the board will only show the selected 
type of elements: Either text or lights. 

c) Initial View: by double-clicking this item, the board returns to its original 
condition, which means ending filter and order operations. 
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Edition Operations 
The edition menu 
helps to add, 
modify or eliminate 
data from the 

tion board. 

project. 

This menu component contains all the data entry forms for all the different phases of 
the project. Here, the user can either enter directly to the forms or use an ac

 

Edit Organizations 
To modify, update or eliminate cards of specific organizations which were previously 
entered. The option Edit/Organizations and Key Informants is used; a catalogue of 
the organizations entered in the data base is attached. To access the card of the 
organization, double-click the grey box that appears on the left side of the name of the 
organization. 

 

 

Edit Transactions 
When a transaction needs to be edited in order to complete, modify, update or eliminate 
information, it is important to keep in mind that the NASA RTS transactions are 
segmented in two phases. The first phase corresponds to the relation between source 
and agent. The second phase corresponds to the relation between agent and provider. 
NASA RTS maintains this desegregation and has two completely independent catalogues 
to access the registers of the two different phases. In order to keep the integrity and 
consistency of the design, these catalogues have the same structural design, but with 
different contents. To access a transactions that was previously entered, double-click 
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the grey box that appears on the left side of the selected transaction. A box will open, 
providing detailed information of the opened transaction. 
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Evaluation 
  

 

Assessment 

 The HIV/AIDS spending estimation starts with related activities that prepare the 
study. There are three kinds of activities to accomplish: a) gather and structure 
information about spending and spending estimations in the past; b) create 
relationships between key informants to reconstruct the financial frame of the area, 
specific towards AIDS; c) consultation and information of potential sources and 
users of the information.  

   

Step 1:  Mapping Financing Flows 

 A first step to a complete NASA is the mapping of actors that play a role in the financial 
flow. This qualitative step is done without any financial data and serves to map the 
organizations are involved in the exercise and can serve as potential sources of 
information. The diagram below was presented by Daigre et al. in the study of the 
Chilean AIDS Accounts, 1999-2000: 

 

 
It is recommended to design such an approximate board of actors. Some of the entities 
are institutional which means their administrative and accounting registers may bring 
information about their expenditures. It may occur that funds are distributed amongst a 
group of entities. 
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Step 2:  Supervision of the Information Gathering 

 This form contains a printable verification sheet that can be filled by the supervisor of 
each component of data gathering. It evaluates progress, the relation with the sources 
of information, quality of the register and of the obtained information. At the end, it 
includes recommendations addressed to the responsible of the component. 

 

 

 

 

 

 

 

 

 

 

 

28 



NASA RTS: User Guide 
UNAIDS 

Step 3:  Quality control of the data 
 

 
 
 

 
This printable form contains different aspects that need to be verified while gathering 
the data of each component. Besides the identification data, it also contains the 
affirmations that appear in the illustration. By marking a statement it indicates that 
there are no problem areas left; the points that remain unmarked are the origin for the 
recommendations that are shown at the bottom of the sheet. The form has a button to 
send it to the printer. 
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Balance 
NASA RTS establishes a segmentation of financial flows in two phases (source-agent 
and agent-provider) as already seen. The system stores this information in different, 
independent spaces. This was necessary to create the mechanism that identifies any 
entries that do not match for any reason.  
Using the entity of the financing agent as the linking point, the program creates a 
diagram with the amount that a financial agent has received and relates it to the 
amount the agent has executed. This generates a balance, which can be either positive 
or negative, according to the information available at this specific moment. 

 

 

Catalogues 
To ease the review of the classifications 
used throughout the estimation the list of 
catalogues that are used in the selection 
forms of source, providers, function, 
budgetary items and target groups has 
been included, in the report menu. Each 
catalogue has a print-ready format, which 
can facilitate the organization of the data 
before it is entered into the program. 
By selecting any of the catalogues a 
preview of the printable file appears. The 
user can export this to Word or Excel, to 
apply styles or formats or to incorporate 
the content into another document. 

The illustration shows the preview page. Different views can be selected. The catalogue 
of financing sources appears in the illustration below. The format of this catalogue is the 
same used with the other four. 
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Matrix 
The matrices included in the report menu can be printed or exported. Besides 
considering the dimension characteristics, borders and font types for printing, a 
fundamental difference between the consultation matrices and the printing matrices is 
that the latter have row and column totals. The matrices do not close until all 
transactions are closed. Therefore, the totals during the intermediate consultation 
matrices are not final and can lead to confusions. Instead, the printable matrices 
assume that the end of the estimation has been reached, or that the final data match is 
nearly finished, so that the printing of the document can contribute to find the missing 
data. 

 
 
 
The source-to-function flow is presented in the illustration. Due to the width of the 
matrix, it is presented in two pages, each one showing two headings of the row. In the 
upper part of the first image, the closing window, print report, zoom in/zoom out, 
export to Excel or Word and change of view command are displayed.   

When an exit design panel is developed, the printing device will also be created. That 
allows the user to develop his personal boards as well as print or export these. 
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This screen shows one of the main advantages that have been achieved compared to 
previous versions of the program. Specifically the evolution of the access platform 
reflects flexibility through a wide range of tools in representing the results. It allows a 
series of actions to facilitate the analysis of the data.  
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Tools 
The tools menu contains resources that will 
facilitate the maintenance of the data base. 
The options to update the current page, add 
a user to the active project and compact and 
repair the database are included in this 
menu. With the exception of the add user 
option, all commands in this menu constitute 
resources of Microsoft Access. That is the 
reason why the language they appear in the 
menu depends on the language of the 
Microsoft Office version that is installed on 
the computer. How these commands are 
executed, is described in the following 

paragraphs. 
 
 

Update current page 
Whenever data is added and rectifications occur, some calculated fields or open system 
reports may show the information how it was before the changes were entered: this 
means that a report update after the entry of the new data has not been done. The 
update current page option refreshes the information starting from the basic tables to 
the recalculation of the totals. 
 
 

Add user 
More than one user can be assigned to the task of entering data to the same project. A 
new user can be entered anytime in the Tools Menu. A different user can log on to 
NASA RTS and edit data of the project as soon as the previous user has signed off. 

 

 

 

 

By selecting the add user 
option in the tools menu, a 
window asking for the new 
user data will appear: the 
number of identification (ID) 
will be automatically assigned 
by the system, the name and 
position of the person, and the 
password need to be entered 
manually. The password then 
needs to be confirmed. By 
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clicking the OK button, the user confirms the entered data. 

When accepted, the window will close and the Project will stay open with the original-
user name. A new user has been added. He/She can log on after the current user has 
logged of the project. After logging on, NASA RTS will show a catalogue of projects that 
the user has access to. He/She can choose the project that he/she wants to edit. 

 

 

Compact and repair data base 
In the tools menu of NASA RTS an Access command has been included. This command 
serves to avoid the accumulation of internal links of the database that have been lost 
because of closing a project accidentally or due to an energy loss or an error message in 
the data entry.  
The operation to compact and repair the database is conducted automatically by double-
clicking the command on the menu. The database compact and repair operation has to 
be completed periodically, even when there is no suspicion of an energy interruption or 
any other error. 
 
 

 
To do this all active projects should be closed on the Project/Close menu, and then 
select the command Compact and repair database on the Tools menu. 

 

 

 

 

Import a NASA RTS database from another computer 

 NASA RTS is a system of integral databases. It provides support to the collection and 
integration of information regarding expenses on HIV and AIDS in different countries.  
This information system contemplates a container of storage which responds to the 
different requests of the estimation exercise.  It is important to know that this container 
was designed specifically for this purpose only, which means it cannot be modified or 
eliminated. The container is required for the good operation of the system.  It is very 
important to note that an inappropriate use of this file can result in the loss of 
information. Nonetheless, the system can transfer the information from one computer to 
another in 5 steps.   

 

Preparing for the transfer  
It is not recommended for the transfer the complete system through a common copy 
and paste command, since a series of underlying calculations, commands and menus 
exist that cannot be copied this way.  The recommended method to install databases is 
to use a new computer to which databases can be transferred, using the most recent 
installer of NASA RTS that can be retrieved here: 

http://www.unaids.org/en/KnowledgeCentre/HIVData/Tracking/Nasa.asp.    
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Location of the database  
To locate the database containing the 
information that is to be transferred into 
the new computer follow the path in 
figure 1. The file is called DBNASA.mdb 
and can be found in c:\NASA\bookstore. 
This is the file that should be copied and 
pasted in the new computer in the same 
location.   

Mi PC

Libreria

Disco C:

DB DBNASA.mdb

NASA

 

                                                                               
       Figure 1            

 

 

 It is of utmost importance not to confuse the file that contains the 
information with the one that was created during the installation of NASA 
RTS. By copying the database to another computer which has NASA RTS 
already installed, one way of avoiding to overwrite the existing database, is 
to rename the DBNASA.mbd (e.g. DBNASA_Guatemala_2005.mbd). This 
way data will not be overwritten and lost. 

 

Copy data base 
Copy the DBNASA.mdb to a data storage tool like a CD, USB Stick, or even as an 
attachment to an e-mail.  

 

Exporting the data base 
The storage tool that contains the copied file with the NASA RTS information should be 
placed in the new computer. The location of this file should have the same route of 
access c: \NASA\Bookstore (Libreria) as was shown in figure 1. To exportor back-
up the database file, the software has a very user-friendly shortcut presented in the 
next chapter. 
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Exporting or Back-up of the Data Base 
It is very simple to export the 
database or to make a copy. The 
user just goes to the Windows start 
menu / NASA and then selects 
“Exporting”. This opens a folder 
where a copy of the DBASE.mbd is 
made automatically. From there it is 
just a matter of “copy-paste” as 
explained above. It can be saved to another computer or on a CD or any another device 
as a back-up. The data can also be sent to an email recipient. 

It is strongly recommended 
to do regular back-ups 
(every few hours) to save 
the work and avoid data 
loss. 

 

 

 

 

 

 

 

 

 

 

 

Emigrated Data verification  
The only thing left for the user to do is to  open NASA RTS from the new location, in 
oder to verify that all the information is accessible.  
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Configuring system in multi user mode 
 

 The new version of NASA RTS has a multi-user application. This means that different 
users can have access to a database at the same time.  This is a great advantage in 
processing information since it permits simultaneous access.  For this to work, the user 
should install the system in a configuration as shown in the following picture. 

 

 

 

 

Step 1:  Installing different users. 
Using the installer Setup NASA RTS.exe the user should install the complete system in 
each of the stations that will work on the NASA project(s), as well as execute the 
different steps of creating a project explained in this manual. 

 

Step 2:  Installation and configuration of the server  
To install the server the user should be logged on as network administrator to be able to 
provide certain services to the different users of the system. Again using the installation 
file the system performs the installation of NASA RTS in the conventional way. After this, 
it is necessary to locate the folder bookstore that is found inside the NASA-folder. In 
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order for everyone to have access, it is necessary to share the bookstore folder. This 
can be done in the folder properties.  

 Please make sure to share this folder and giving the permission of reading 

and writing to all users that will need to access and work on the information.  

 

 

Step 3:  Re-Addressing of the users  
 This should be done in each of the 
workstations where NASA RTS has been 
installed. 

In the Tools menu the user will find the 
Select Data Base command, as shown in 
the picture. 

By clicking this option, a window will open 
up that shows all the files of the system 
that require being re-operated.  

 

 

It is very important to execute the following steps to connect the adequate databases to 
the newly installed system.  

1. Select all boards at once with the button select all.   

2. Make sure to tick the box Always prompt for new location.   

3. Click the button OK. 

4. Choose a new locate for the file DBNASA.MDB (save it in the shared folder 
Bookstore on the server) 
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Security 
Whenever a new database is installed, the user needs to set the level of security.  If the 
level of security is very high NASA RTS will ask the user if he really wants to open the 

program every time the program is 
started up. 

 

To avoid this the user should reduce 
the level of security. This is no risk 
that would jeopardize the equipment. 

 

 

   

 

In order to lower the security 
level, select the security button 
in the tools menu and tick 
option low. Clicking Ok 
confirms the new security 
standard. 

The program should now start 
without any problem. 
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Output for Pivot Tables 
 

1. Select the option Beneficiary population or Production factors on the Menu 
“Report/Output”: 

 

 

 

 

 

2. Export the data to Excel by clicking on the Excel icon in the menu: 

 

 

 

 

3. Export the data to Excel by clicking on the Excel icon in the menu: 
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The data in Excel contains data entered to RTS. Data in columns contains: a) 
transaction number, b) country, c) year, d) FS Institution Name, e) FS Institution Name, 
f) PS Institution Name, g) FS code description, h) Financing Agent code, i) FA code 
description, j) Provider code, k) PS Code description, l) ASC, m) ASC Code description, 
n) Beneficiary population, o) BP Code description, and p) Amount.  

4. Data in columns is arranged in a way that can easily be exported to a Pivot Table. To 
create a Pivot table go to Data/PivotTable and PivotChart Report: 

 

 

 

Select “Finish”, and a Pivot table will be created on a new sheet. 
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4. To create a matrix, drag and drop items from the “PivotTable Field List” to the Row, 
Column and Data Fields.  

 

 

 

In this way all matrixes FS-FA, FS-ASC, FA-ASC, FS-PS, FA-PS, PS-ASC, FS-BP, FA-BP, 
ASC-BP and PS-BP can be recreated: 

 

 

 

Using the output “Production Factors” mentioned in step 1), the following matrixes could 
be created repeating steps 1 to 4: FS-FA, FS-ASC, FA-ASC, FS-PS, FA-PS, PS-ASC, FS-
PF, FA-PF, ASC-PF and PS-PF 
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